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Transfer Overview 
The ProCAP Transfer Application ensures accurate and consistent encoding of 
captions to video. 
  

 
  
Transfer files generated from the ProCAP Authoring System can be sent to the 
Transfer Application over a network or on floppy for encoding to video. 
  
Transfer files are a series of events, with each event having caption data to be sent 
to the encoder at a specified time code. 
  
The Transfer Utility is time code driven from the Master source, and sends the 
event data to the Encoder appropriately, according to the current input time code.  
This allows the Transfer Utility to track the Master source even when it is paused, 
jogged, or shuttled.  Once the Master source returns to normal play forward, the 
Transfer Utility prepares for the next complete event that it can send out.  Partial 
events or events for time codes that have been skipped are all skipped by the 
Transfer Utility. 
  
No caption processing is done during transfer. 
  
The Transfer Utility can communicate with any encoder that supports the NCI 
Control-A , or EEG Smart III, compatible protocol. 
  
The Transfer Utility supports the following caption file formats: 

 ProCAP Transfer files 
 NCI caption files 
 WGBH TDS caption files 
 Cheetah .CAP version 2 binary caption files 

  
In order to import NCI and/or Cheetah files, Microsoft Office and ProCAP must also 
be installed into the Transfer system. 
  



Transfer Utility 
Before using the Transfer application, the Encoder and Time Code Reader 
configuration section should be reviewed.   
  
To start the Transfer Application, from the Windows Start Menu choose 
Programs ProCAP ProCAP Transfer Utility.   
  
Open the transfer file from the Transfer Application menu File Open, or by 
using the Open existing file  command button on the command bar. 
  

 
  
Locate the transfer file that was created, highlight the file and press Open. 
  
An example of a transfer file loaded: 
  



 
  
  
At this point, the user should verify that the starting time code (STC) in the transfer 
file is the same as the master video.  If the times differ, there are several options: 

1. Go back to the Source Caption File in the ProCAP Editor, and verify the time 
codes of the Source Video File with the Master File 

2. Move the time code in the ProCAP Editor 
3. Change the time code in the Transfer file 

  
Once the time code is verified, then the transfer file is loaded into the queue.  
Loading the transfer file can be done: 

 from the Transfer Application menu execute Transfer Load 
 by pressing the Load   command button 



 by executing Ctrl+L 
  
To start encoding 
  

1. Cue and Play the Master VTR.  Now, the source time code will appear on 
the bottom status bar in the Transfer Utility. 

  

 
  

If there is no time code on the Transfer Utility bottom status bar, then  there 
is a problem with either the time code reader card, or the time code source is 
not connected properly or there is an issue with the master dub.   See Time 
Code Reader Problems for more information. 
  

2. Start the Transfer Utility encoding by: 
 executing Transfer Start Encoding from the Transfer Utility menu 
 pressing the Go  command button  
 executing Ctrl+E 

  
3. Press Record on the Dub VTR. 

  
  
Once the transfer operation is complete, stop the encoding process by either: 

 executing Transfer Stop Encoding 
 pressing the Stop  command button 
 executing Ctrl+D 

  
Before starting another transfer unload the current transfer file.  This is done by 
either: 

 executing  Transfer Unload 
 pressing the Unload  command button 
 executing Ctrl+U 



Setup 



Introduction 
The set up section of this manual, explains how to set up and install the ProCAP 
Transfer Utility system on a personal computer. 
  
If the ProCAP Transfer Utility was pre-installed on a system, then this section titled 
Setup, is not relevant.  Proceed to a Tour of the Transfer Utility. 



Minimum Requirements 
In order to guarantee reliable performance of the transfer application, a PC 
Compatible system with the following specifications is recommended: 
  

 Pentium III 450+Mhz 
 One free ISA slot for the time code reader card 
 One free serial port for encoder communications 
 One parallel port for the ProCAP authorization key 
 128+MB RAM 
 CD-ROM or DVD-ROM drive 
 Windows 2000 SP1 
 A minimum of 5MB of hard drive space for the transfer application 
 Microsoft Office 2000 SR1 Small Business Edition if NCI and Cheetah file 

import capability is required 
  



Installation 
There are three steps to be followed when installing the Transfer Utility.  
  

1. Hardware Setup to install the Time Code Reader Card and the ProCAP 
Authorization Dongle.   

2. Transfer Setup to install the Transfer Utility  
3. System Configuration to install the support software for NCI and Cheetah 

import 



Hardware Setup 
Prior to installing the Transfer Utility: 
  

1. Install the Time Code Reader Card.  For installation software and detailed 
instruction, refer to the  accompanying manual.   

  
 The computer bios must be updated to reserve the UMB address range 

occupied  by the Time Code Reader Card. 
  

2. Install the ProCAP Authorization Dongle: 
 Identify the parallel port.  This port can be identified as the DB-25 (25 pin 

female connector) 
 If a printer is connected to the computer, disconnect the printer 
 Secure the Dongle to the parallel port 
 Re-connect the printer cable to the Dongle 

  
3. Connect the Encoder to the serial port on the computer: 

 Identify the free serial port.  This port can be identified as a DB-9 (9 pin 
male connector) 

 Connect the serial cable of the encoder to the serial port. 
  



Transfer Setup 
To install the Transfer Utility, run the Setup Program from the ProCAP CD.   

  
 Insert the ProCAP CD into the CD-ROM or DVD-ROM drive 
 From the Windows toolbar, select Start Programs Windows Explorer 
 In the Latest ProCAP directory, open the Transfer folder 
 Execute the Setup Program  
 Follow the prompts that are given during installation and accept the defaults 
 Complete the installation 

  
Once the Setup program is complete, you will have a program group called 
ProCAP Transfer Utility. 



System Configuration 
For NCI and/or Cheetah file import support, additional system software must be 
installed. 
  

Microsoft Office 2000 SR1 must be installed and run prior to installing the 
ProCAP Authoring Application.   
  
To install the ProCAP Authoring Application: 

  
 Insert the ProCAP CD into the CD-ROM or DVD-ROM drive 
 From the Windows toolbar, select Start Programs Windows Explorer 
 In the Latest ProCAP directory, open the ProCAP folder 
 Execute the Setup Program  
 Follow the prompts that are given during installation and accept the defaults 
 Complete the installation 
  

This completes the system configuration. 
  
  

  



Encoding Transfer Files 



Loading Transfer Files 
In order to load a transfer file into the transfer utility, you will first have to transfer 
the ProCAP caption file to a transfer file.  If not done previously, the Creating a 
Transfer File section should be reviewed. 
  
To load in the transfer file: 

 execute File Load 
 press the Open File   command button  

and browse to the file you want to open and click the Load button. 
  
An Editor window will open with the loaded transfer file. 
  
If the master dub and the recorded video are not of the same time code, you may 
have to change the time code in the transfer file.  This can be easily accomplished 
with the Set New Time code command. 
  
The transfer events can now be loaded by: 

 executing Transfer Load 
 executing Ctrl + L 
 pressing the Load   command button 

  
At this point all events are queued into the transfer process. 
  



Start Encoding 
Once the transfer file has been loaded and the events are queued, you are ready 
to start the actual transfer. 
  
Before you commence with the transfer, the dub operation should be ready to go.  
You can proceed by setting up the VTRs for the dub.   
  
Once the VTRs are ready to dub, start the transfer by: 

 executing Transfer Start 
 pressing the Go  command button 

  
If a start of captioning marker is present, the encoder will not start encoding until 
the time on the marker.  If the marker does not exist, the encoder will start 
encoding once you start the transfer. 
  
At this point, you should ensure that the dub is proceeding properly. 
  
If the VTR is shuttled forward or in reverse, the transfer application will drop any 
captions that it could not send and requeue itself to the next caption with the 
current time code. 
  



Stop Encoding 
Once the master dub is complete, to stop the transfer: 

 execute Transfer Stop 
 press the Stop  command button 

  
Stopping the transfer guarantees that the encoder is no longer encoding to video.   
  
If you have an End of Captioning Marker in the transfer file, the encoder will be 
disabled at this time.  However, if the VTR is the reversed, the encoder can start 
encoding again. 
  
  



Unloading Caption Files 
Once the transfer operation is stopped, the file can be unloaded from the queue 
by: 

 executing Transfer Unload 
 pressing the Unload  command button  

  
Once the file has been unloaded, the file can be closed, saved and the Transfer 
Utility is closed. 



Closing the Transfer Utility 
To close the transfer application, first stop encoding and the unload the transfer file 
by: 

 executing File Exit 
 pressing the Close Application  command button on the top right of the 

window to close the Transfer Utility. 



Importing 



Cheetah Import 

To import a Cheetah .CAP caption file, execute File Import from the Transfer 
application main menu.  Use the Open dialog box to browse to and select the 
Cheetah .CAP file you wish to import.  Press the Open button to start the import 
operation. 
  

Currently, ProCAP only supports import of the Cheetah Version 2 .CAP binary 
files. 
  
The progress of the Cheetah .CAP import process is displayed.  The import 
process uses the ProCAP Authoring application to convert the Cheetah captions 
into a ProCAP caption file, before generating a standard ProCAP transfer file. 
  
Once the import process has completed, the imported Cheetah file is loaded and 
ready for regular transfer operations to be started. 
  
  

Cheetah import is only supported if the ProCAP Transfer dongle, ProCAP 
Authoring application, and Office 2000 or later, are installed and operational.  To 
install these components, please go to the System Configuration section in the 
Setup section. 
  
  



NCI Import 

To import a NCI caption file, execute File Import from the Transfer application 
main menu.  Use the Open dialog box to browse to and select the NCI file you wish 
to import.  Press the Open button to start the import operation. 
  
The progress of the NCI import process is displayed.  The import process uses the 
ProCAP Authoring application to convert the NCI captions into a ProCAP caption 
file, before generating a standard ProCAP transfer file. 
  
Once the import process has completed, the imported NCI file is loaded and ready 
for regular transfer operations to be started. 
  
  

NCI import is only supported if the ProCAP dongle, ProCAP Authoring 
application, and Office 2000 or later, are installed and operational.  To install these 
components, please go to the System Configuration section in the Setup section. 
  



TDS Import 

To import a WGBH (The Caption Center) TDS caption file, execute File Import 
from the Transfer application main menu.  Use the Open dialog box to browse to 
and select the TDS file you wish to import.  Press the Open button to start the 
import operation. 
  
Once the import process has completed, the imported TDS file is loaded and ready 
for regular transfer operations to be started. 
  



Changing Time Code 
If the transfer file has a different time code than that of the master video, changing 
the time code is very easy to do. 
  

It is recommended that a start of video marker is placed at the beginning of the 
caption file to ensure that the time code offset is accurate. 
  

Changing the Entire File 
To change the offset of the entire transfer file, make sure that there is no selection 
in the file. 
  
Choose Edit Set New Timecode or press CTRL-T to open the time code dialog 
box. 
  

 
  
Enter the new time code to change the transfer file to.  Click OK to continue. 
  
The transfer file will now be parsed and all of the time code will be updated. 
  

Changing Blocks of Time Code 
To change only sections of time code, simply highlight the block of captions: 
  



 
  
Choose Edit Set New Timecode or press CTRL-T to open the time code dialog 
box. 
  

 
  
Enter the new time code to change the transfer file to.  Click OK to continue. 
  
The block will now be parsed and the time code will be updated. 



  



Configuration 



Timecode Reader 
Configure the time code reader rate to reflect that of the time code source.  If a 
standard VITC or LTC signal is used, the default settings should be used. 
  
The Time code cards combo box will list any time code reader cards that are 
installed into the system. 
  
Press the Test button to ensure that the reader is being detected and that the time 
code is being read. 
  

 
  
  
If any changes are made, press the Save button to save the new configuration. 



  



Encoder 
The default encoder initialization settings and control settings should be kept as 
the default settings.  These are the common configuration strings for a Control-A 
protocol, or EEG Smart III, compatible encoder. 
  

 
  
  
To ensure that the settings are correct, press the Test button.  A dialog box should 
display with an asterisk (*) as the encoder response. 
  



 
  
If the encoder is not properly connected, the dialog box will state that the serial port 
has timed out.  This error can also display if the proper bit setting and parity is not 
set correctly. 
  

 
  
You can perform an extended test by copying the initialization string from the Init 
box and pasting it into the test box.  The following is an example result using an 
Evertz Encoder. 
  

 
  
  
The encoder delay is the delay, in fields, that the encoder introduces to the stream.  
Consult the user manual or the vendor for the proper setting of this field. 
  
Saving Changes 
  

Once the encoder configuration has been set, you can save the changes into 
your own profile by typing in a profile name in the profile box and clicking on the 
Save button.  Changes can be saved to the default profile, but these may be 
over-written by software updates. 



  
Click on the OK button to close the configuration menu. 
  
Loading A Different Profile 
  
If you have more than one encoder, you can switch between profiles by pulling 
down the profile combo box by clicking on the down arrow. 
  

 
  
This will display the all of the saved profiles.  Highlight the profile you wish to load 
and click the load button. 
  
Deleting Profiles 
  
If you have more than one profile and wish to delete the uneeded profiles, pull 
down the profile combo box by clicking on the down arrow and choose the profile 
you wish to delete.  Click on the delete button to delete this profile. 
  

If you have deleted all of the profiles, the next time you start ProCAP a new 
default profile will be created. 
  
  
  
. 



Computer Communications 
Configure the COM Port Settings to reflect that of the encoder serial 
communication settings.  Refer to the encoder manual for details on the 
communication settings. 
  

 
  
To ensure that the settings are correct, press the Test button.  A dialog box should 
display with an asterisk (*) as the encoder response. 
  



 
  
If the encoder is not properly connected, the dialog box will state that the serial port 
has timed out.  This error can also display if the proper bit setting and parity is not 
set correctly. 
  

 
  
You can perform an extended test by copying the initialization string from the Init 
box and pasting it into the test box.  The following is an example result using an 
Evertz Encoder. 
  

 
  
  
The encoder delay is the delay, in fields, that the encoder introduces to the stream.  
Consult the user manual or the vendor for the proper setting of this field. 
  
Saving Changes 
  

Once the encoder configuration has been set, you can save the changes into 
your own profile by typing in a profile name in the profile box and clicking on the 
Save button.  Changes can be saved to the default profile, but these may be 
over-written by software updates. 



  
Click on the OK button to close the configuration menu. 
  
Loading A Different Profile 
  
If you have more than one encoder, you can switch between profiles by pulling 
down the profile combo box by clicking on the down arrow. 
  

 
  
This will display the all of the saved profiles.  Highlight the profile you wish to load 
and click the load button. 
  
Deleting Profiles 
  
If you have more than one profile and wish to delete the unneeded profiles, pull 
down the profile combo box by clicking on the down arrow and choose the profile 
you wish to delete.  Click on the delete button to delete this profile. 
  

If you have deleted all of the profiles, the next time you start ProCAP a new 
default profile will be created. 



Menus 



File Menu 
Choose the following commands in the File Menu: 
  
Name 
  

  Description 

New   Opens a new transfer editor 
Open...  Displays the open dialog box 
Save  Saves the current file 
Save As...   Prompts for new name to save the current file 
Print... 

 
Prints the current edit file 

Page Setup...   Sets up the page for printing 
Recent File   Displays the latest 5 files that were opened 
Close   Closes the current edit window 
Exit   Exits the transfer application 
  
. 



Edit Menu 
Choose the following commands in the Edit Menu: 
  
Name 
  

  Description 

Undo   Undoes the last change made in the edit window on the 
transfer file. 

Cut  Cut the highlighted section into the clipboard. 
Copy  Copy the highlighted section into the clipboard. 
Paste  Paste the contents from the clipboard into the current 

location. 
Delete   Delete the selected section. 
Select All   Select the entire transfer file. 
Date/Time   Enter the current date/time into the current location. 
Set New Time 
code 

  Set a new time code for the highlighted section or the 
entire document. 

Set Captioning 
Channel/Field 

  Over ride the current captioning channel/field. 

  



Search Menu 
Choose the following commands in the Search Menu: 
  
Name 
  

  Description 

Find...  Search for a string within the transfer file. 
Find Next   Find the next occurrence of the string within the file. 
Find Previous   Find the previous occurrence of the string within the file. 
Replace   Perform a search and replace of the given string. 
Replace Next   Replace the next occurrence of the given string. 
  
  



Options Menu 
Choose the following commands in the Options Menu: 
  
Name 
  

  Description 

Font   Change the font of the specified selection of text 
Selection Font     
Background 
Color 

  Change the background color of the transfer file 

Text Color   Change the text color of the specified selection of text 
Rich Text   Toggle rich text view. 
  
  
  



Transfer Menu 
Choose the following commands in the Transfer Menu: 
  
Name 
  

  Description 

Load  Load the current transfer file into queue 
Unload  Unload the current transfer file from the queue 
Capture   Perform a capture of the video stream* 
Start Encoding  Start the encoding process. 
Stop Encoding 

 
Stop the encoding process. 
  

  
*Only available with the Transfer Hardware key.  Must have a closed caption 
decoder in order to capture. 
  



Configuration Menu 
The Configuration menu configures the encoder or time code reader card.  For 
details of these operations see the configuration section. 



Window Menu 
Choose the following commands in the Window Menu: 
  
Name 
  

  Description 

Tile Horizontally   Tiles all open file windows horizontally 
Tile Vertically   Tiles all open file windows vertically 
Cascade   Cascade all open windows 
Arrange Icons   Arrange any minimized file icons 
Window List   Lists all current file windows.  The checkmarked 

window is the current window. 
  
  



Help Menu 
Choose the following commands in the Help Menu: 
  
Name 
  

  Description 

Contents   Displays the help file table of contents 
Index   Displays the help file index 
Search   Displays the help file search dialog box 
About   Displays information about the Transfer application 
  
  



Transfer Problems 



Time Code Reader 

No Time Code Reader Found 

If no Time Code Reader is listed in the Timecode Cards drop-down dialog box on 
the Time Code Configuration window, the low-level driver for the Time Code 
Reader is not installed or not configured correctly. 
  
Confirm the settings of the Time Code Reader card during initial power-on of the 
system.  The default address of the Time Code Reader card is DE00. 
  
Follow the instructions for the Time Code Reader card manual and installation 
software to reinstall the low-level driver and registry entries. 
  
No Time Code Present 

If no time code is present after pressing Test on the Time Code Configuration 
window, verify the time code source is present and that it is connected to the 
corresponding Time Code Reader input. 
  
The Time Code Reader typically has two RCA connectors for unbalanced analog 
LTC and analog NTSC composite VITC inputs.  The VITC input is closest to the 
DB-9 connector on the Time Code Reader card. 



Encoder Communication 
If your encoder is connected properly and the transfer application complains that 
the serial port has timed out,  you may have the serial port settings set incorrectly.  
Review the section on configuring the encoder to ensure proper communication. 
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